
Content Manager
Software Version 10.1

Release Notes

Document Release Date: October 2024
Software Release Date: October 2024



Legal notices

Copyright notice

© Copyright 2008-2024 Micro Focus or one of its affiliates.

The only warranties for products and services of Micro Focus and its affiliates and licensors (“Micro Focus”) are
set forth in the express warranty statements accompanying such products and services. Nothing herein should
be construed as constituting an additional warranty. Micro Focus shall not be liable for technical or editorial
errors or omissions contained herein. The information contained herein is subject to change without notice.

Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® andWindows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

This product includes an interface of the 'zlib' general purpose compression library, which is Copyright © 1995-
2002 Jean-loup Gailly and Mark Adler.

Documentation updates
The title page of this document contains the following identifying information:
l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

You can check for more recent versions of a document through the MySupport portal. Many areas of the portal,
including the one for documentation, require you to sign in with a Software Passport. If you need a Passport, you
can create one when prompted to sign in.

Additionally, if you subscribe to the appropriate product support service, you will receive new or updated editions
of documentation. Contact your Micro Focus sales representative for details.

Support
Visit the MySupport portal to access contact information and details about the products, services, and support
that Micro Focus offers.

This portal also provides customer self-solve capabilities. It gives you a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can
benefit by using the MySupport portal to:

l Search for knowledge documents of interest
l Access product documentation
l View software vulnerability alerts
l Enter into discussions with other software customers
l Download software patches
l Manage software licenses, downloads, and support contracts
l Submit and track service requests
l Contact customer support
l View information about all services that Support offers

Many areas of the portal require you to sign in with a Software Passport. If you need a Passport, you can create
one when prompted to sign in. To learn about the different access levels the portal uses, see the Access Levels
descriptions.
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Micro Focus Content Manager Release Notes

Introduction to Content Manager 10.1

Micro Focus Content Manager is a governance-based enterprise content management system
designed to help government agencies, regulated industries, and global organizations manage their
business content from creation to disposal.

With tight desktop integration and the ability to scale across large, distributed environments, Content
Manager lets organizations capture, classify, manage, access, and secure enterprise information,
from electronic to physical records, including Microsoft 365. Regardless of content creation and
collaboration, Content Manager abilities let organizations leverage accurate, contextual, and
complete information throughout its lifecycle. Managing content this way helps significantly improve
serviceability, business decisions, and insight for future strategy.

Content Manager provides document and records management, e-mail management, web content
management, imaging, workflow, and document-centric collaboration to organizations worldwide.
Developed with more than three decades of information management expertise into comprehensive,
"out-of-the-box" software and a cornerstone of the Micro Focus Secure Content Management Suite,
Content Manager enables organizations to lower operating costs, secure information, enhance
compliance, and increase productivity.

By focusing onWeb Client capabilities; SharePoint, OneDrive, Office features; life cycle
management, and SDK improvements, Content Manager 10.1 addresses the areas of cost,
compliance, productivity, information privacy, and security.

Content Manager 10.1 is designed to support the International Standard of Records Management
(ISO 15489:2001), and elements of ISO16175: Principles and Functional Requirements for Records
in Electronic Office Environments.

Overview of Content Manager

This is the sixth patch release of the Content Manager 10.1 program series. This release includes all
fixes and enhancements that were shipped in the previous releases of Content Manager. For details
of the previous releases, please refer to the relevant release notes.

This release includes support for English (International), English (US), French, Spanish, and Dutch.

For technical details, including the support matrix, refer to CM10.1_Spec.pdf and CM10.1_
Install.pdf.

The authoritative list of fixed change requests included in this release can be found on

https://kmviewer.saas.microfocus.com/#/PH_217829

IMPORTANT:
The configuration information forOpenID connect authentication, Zero footprint Office
integration,MS Teams integration, andMobile App setup, in the SDK help
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(https://content-manager-sdk.github.io/Community/101/release_notes.html) has been made
available in the PDF documentation. Further updates to the configuration information, if any,
will be available as part of the below mentioned PDF documents. Customers who have
developed SDK applications or add-ins should refer to the following documents:

l CM10.1_OpenIDAuthentication.pdf

l CM10.1_Zerofootprint_Integration.pdf

l CM10.1_MSTeams_Integration.pdf

l CM10.1_MobileApp_Setup.pdf

The list of defects and enhancements included in this release can be found on the Micro Focus
Support Portal Knowledge Base.

To access the included items, on the Support Portal Knowledge Base page:

l Select Content Manager (Records Manager/TRIM) as the Product filter

l To display the list of included Defects, select Known Problems as the Document Type filter.

l To display the list of included enhancements, select Enhancement Requests as the Document
Type filter.

l Type 10.1 into the Search Terms field and then click Search.

NOTE: A single Document Type filter can only be applied at a time, please ensure to clear
the Document Type filter before selecting another filter type.
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Additional Content for the 10.1 Patch Releases

Patch 1

The following details have been added to the 10.1 Patch 1 version of this document:

l Global Temporary Table

Patch 5

The following details have been added to the 10.1 Patch 5 version of this document:

l Content Manager Document Icons , on page 9
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New Install and Upgrade Considerations

OpenID Connect authentication - Content Manager
redirect URI

Earlier, Content Manager used urn:ietf:wg:oauth:2.0:oob as the redirect URI for OpenID Connect
authentication. This redirect URI is deprecated by some of the OIDC providers. So, the redirect URI
for OpenID Connect authentication has been changed from urn:ietf:wg:oauth:2.0:oob to
https://127.0.0.1.

Content Manager stored procedures

You must install the following stored procedures as part of the patch upgrade process:

Order of stored procedure to be installed:

1. tsAclOthersCheck

2. tsAclRTAndFPCheck

3. tsAclRecordCheck

4. tsAclWorkflowCheck

5. tsAclCheck

6. tsAclStoreCheck

To manually install the stored procedure, perform the following steps:

1. In the Content Manager Enterprise Studio, right-click on the dataset where you want to install
the stored procedure.

2. Navigate to Schema > Manage. The Schema Manager dialog is displayed.

3. In the left pane, expand Procedures and scroll down.

4. Select the tsAclOthersCheck stored procedures, right-click > Check and then Recreate.

5. Repeat step 4 for all the stored procedures mentioned above.

6. Once all the stored procedures are recreated, click Close to exit out of Schema Manager.

Limit for temporary database size in SQL

As part of architectural modifications, the Content Manager Workgroup Server uses temporary tables
to store data in SQL Server. It is recommended to increase the TempDB size in accordance with the
Content Manager usage and user concurrency, if you have set a limit for the TempDBmax size.
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Support for Visual Studio Tools for Office (VSTO) add-in

Microsoft has announced a change to Outlook for Windows that VSTO add-ins will no longer be
supported in Outlook. If you are using New Outlook view and want to continue using Content
Manager VSTO add-in, then you have to disable or untoggle the New Outlook view.

SQL Text Indexing

In 10.1, the Content Manager text indexing engine that has been in place for many years has been
fully replaced with the Structured Query Language (SQL) text indexing capabilities built in to modern
relational databases. This capability was first introduced in Content Manager 10.0 as an alternative.
From 10.1 onwards SQL text indexing is the only way to index metadata such as titles and notes. As
a result, when upgrading from a version of Content Manager that is earlier to version 10.0, you will
need to factor a complete text reindex into your upgrade plan, or consider a staged upgrade, going
from your current version to 10.0, enabling and indexing the SQL Text Index at this stage, then
upgrading to 10.1. It is recommended that any organization that is running 10.0 should convert to
SQL Text Indexing as soon as it is practical. Text search methods such as Title, Notes and Any Word
searches will not be available in 10.1 until the SQL Text Index is created and indexed. See Content
Manager Enterprise Studio Help > Dataset setup and maintenance > SQL Text Index for details on
creating and reindexing the SQL Text Index.

Text search methods such as Title, Notes and Any Word searches will not be available in 10.1 until
the SQL Text Index is created and indexed.

See Content Manager Enterprise Studio Help > Dataset setup and maintenance > SQL Text Index
for details on creating and reindexing the SQL Text Index.

Oracle RDBMS Permission

For organizations running Oracle RDBMS servers it is recommended that the role assigned to the
schema used needs to be updated to include the Create Job permission.

Behavioral change

Content Manager Document Icons

From Content Manager 10.0 Patch 4 onwards, Content Manager Desktop Client uses authoring
application icons associated with a file type, if available. Otherwise, the Content Manager default
document icons are used.
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New Features

Platform Continuance

Content Manager 10.1 introduces support for:

l IDOL, KeyView and Media Server 12.10

Operating Systems
l Windows 11 (64-bit)

l Windows Server 2022 (64-bit)

Compliance
l Public Record Office Victoria (PROV) Version 3 VERS Encapsulated Objects (VEOs) compliance

Content Manager Microsoft Teams Integration

Theme: Total Cost of Ownership

An important feature in this release is the introduction of the Content Manager Microsoft (MS)Teams
integration. This new integration enables Content Manager to support the archiving of MS Teams
data as records. MS Teams is a collaboration tool that is being increasingly used by organizations for
day-to-day business transactions and being able to capture and manage these transactions provides
organizations with information governance capabilities that have not been previously available as a
seamless integration. This integration provides functionality to allow organizations to automatically
capture conversations, files and post from MS Teams Channels and chats, as well as providing the
option for users to make the record creation decision. Content Manager functionality allowing users
to search for records and view record properties is also exposed within the MS Teams interface.
Content Manager records can also be added to Teams Channels, providing easier access to records
within the MS Teams application.

An administrator can configure MS Teams Channels for automated capture of the data as records in
Content Manager using the Channels group in the Content Manager app. This configuration
interface supports a quick setup of multiple channels for monitoring, which can save administrators
time when configuring the integration for organizations with large numbers of channels. The
administrator can select multiple channels that have the same record creation requirements and
apply the Check In Style to be used in a single update.

A polling frequency feature lets administrators control the reading interval of channels and chats for
record creation. This functionality, along with the additional controls that help split chats into separate
records, helps maintain coherence when searching for records created by the integration.
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Group chats, as well as individual user chats, can also be configured to be captured automatically as
records into Content Manager. This configuration is done in a similar manner to the configuration of
Channels, but it’s done via the People group in the Content Manager app.

Files that are associated in a Channel or added to a post can be created as records in Content
Manager. Content Manager recognizes duplicate posting of the same file within the MS Teams
application and will only create a single record for a shared file. The files that users have in their
OneDrive instance, that is accessible via MS Teams, can also be created as Content Manager
records from MS Teams via theMy Files group in the Content Manager app.

Organizations may prefer to allow users the flexibility to capture Teams channels, chats, group chats
and files manually. The integration allows for this, as well as the automated process described. Using
the Content Manager tab available in the MS Teams Chat or Teams pages, users can select which
chats they want to create Content Manager records with and check these in using the Check In
option.
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For chats that have already been checked into Content Manager, users can view the record
properties from the Chat page – Content Manager tab, and if required, they can open the record in
the Content Manager client, or the Web Client.

Check In Styles are used by the MS Teams integration to apply the default record details used when
creating records. Check In Styles can be created and managed directly from MS Teams, in the
Content Manager app, in the Check In Styles group.

From the Content Manager app in MS Teams, users can search for records, view record properties,
as well as adding records to their Favorites list.
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See CM10.1_MSTeams_Integration.pdf for details on installation and configuration requirements.

Content Manager Mobile App

Theme: User Experience

The new Micro Focus Content Manager Mobile app is a native application that enables users to
securely access Content Manager records from their mobile phone devices. The Content Manager
Mobile app is available on both Android and iOS platforms and can be downloaded and installed from
their respective stores, Google Play or Apple App Store. Mobile users can now create records while
out in the field, including attaching mobile artifacts such as photographs and documents, from their
mobile device, as well as search for and view existing records in their organization’s Content
Manager dataset.

NOTE: This app has been designed and developed for use on mobile phone devices. If users
have a requirement to access Content Manager from a tablet device, the Content Manager
Web Client must be used.
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The Content Manager Mobile App allows users to:

l Securely connect to their Organization’s Content Manager dataset
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l Search for records using Content Manager tray/saved searches and string-based searching

l View electronic documents and record properties
o Displayed record properties can be customized by the user
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l Create new records with electronic document attachments

l Check Out existing documents for editing using a native application, such as Microsoft Word

l Download documents for offline viewing

l Edit and view Office documents in OneDrive
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l Customize the look and feel of the Content Manager Mobile app to suit user’s personal
requirements
o Display the Content Manager Mobile app in a Dark or Light theme

See CM10.1_MobileApp_Setup.pdf for details on installation and configuration requirements.

Content Manager Web Client

Theme: User Experience

Grid View

The Content Manager Web Client now includes an option to display search results in a grid view
format, which provides a similar viewing experience to the Content Manager desktop client. The new
grid view is in addition to the existing list view option and users can toggle between the two options,
allowing for flexibility of working preferences and requirements, as well as user familiarity. Viewing
data in a grid format provides users with the ability to quickly compare data, and users often find this
format easier to understand and interpret.

Release Notes

Content Manager (10.1) Page 18 of 42



The new grid view provides a similar user experience to the grid view in the Content Manager client.
Users can customize the columns included, or excluded, in the view using the Column Selection
option; the order of the columns can be re-arranged by dragging and dropping and they can change
the sort order of the displayed items within the column by clicking on the column header. For those
users who have a requirement to use both the Content Manager Web Client and client applications,
the column settings will be applied when updated in either application. The exception to this is the
column width settings, only the client settings will be pushed to the Web Client, changes made to the
column widths in the Web Client will not be reflected in the Content Manager client. This behavior
allows users who have a requirement to work with both applications to have a consistent look and
feel when viewing and working with Content Manager objects.

Working with objects in the Content Manager Web Client is still the same, regardless of the display
view being used. The Properties/Action panel is opened by a single click on an object, and users can
still update multiple items, where supported, when they are using the new grid view.

Recycle Bin

The ability to send records to the Recycle Bin from the Content Manager Web Client has been
introduced in 10.1. The Recycle Bin functionality in the Web Client is the same as the behavior in the
client. Records are sent to the Recycle Bin via the Action panel, Add/Remove - Add to Recycle
Bin option, and the user must select a reason for recycling as a part of the recycling process. Once
records have been sent to the Recycle Bin, they will only be accessible by users who have the
required user permissions to access them from the Recycle Bin tray displayed from the masthead
menu Records – Recycle Bin option, and if required, the users with appropriate permissions will be
able to Restore records from the Recycle Bin in the Web Client.
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Content Manager Client

Theme: User Experience

Ability to compress the logs

You can now compress the logs of Content Manager Client and Enterprise Studio. The Zip Logs
allows you to compress the log files to a .zip file. The Zip Logs is available in the Setup Information
of Content Manager Client and the Enterprise Studio. Navigate to About > Setup Info > Zip Logs.
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Figure 1: Zip Logs in Setup Information

Figure 2: .zip file in File Explorer

For more information, see Content Manager help.

Property Editor

The new Property Editor option allows users to update the properties of Content Manager objects,
either as a single object update, or as a multiple object update. The advantage of the Property Editor
is that it allows for the update of properties that were previously only accessible from the object
property form which meant that objects, such as Record Types, could only be updated one object at a
time. In 10.1, using the Property Editor, the object properties on multiple objects of the same type can
be updated in a single update.

The Property Editor is accessed via the right-click menu on supported objects.

The supported objects are:

l Records

l Locations

l Record Types

l Classifications

l Thesaurus Terms

l Retention Schedules

l Consignments and Consignment Templates

l Holds

l Workflow Templates

l Origins

l Check In Styles

l Document Queues

l Spaces

l Meetings
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NOTE: As a result of the introduction of the Property Editor, some of the right-click menu
options are no longer required and have been removed. These are:
Records
l Details – Dates

l Details – Record Class

l Details – Other Record Fields

l Details – Custom Properties/ Additional Fields

Locations
l Custom Properties/ Additional Fields

l Other Location Fields

For other objects, where it was supported, the Custom Properties/ Additional Fields right-click
menu option has been removed.

Custom Tooltips

As an extension to the options to add Placeholder Text within fields and Custom Text fields on
Record Entry forms that were introduced in 10.0, Administrators now have the option to add custom
Tooltips to fields on Record Entry forms via the new Tooltip tab available on the Form field Properties
dialog.
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These custom ToolTips will be displayed when users hover their mouse over the field on the Record
Entry form.

Cascade Properties

In the View pane for objects, it is now possible to include properties of the parent property on the child
object’s view pane, so details of the parent object can be seen without having to navigate from the
child object. For example, on records, users can include the additional properties about the container
on the contained record’s view pane. Only properties that can have properties, such as objects, can
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have Cascading Properties applied to them in the view pane. To allow for Cascading Properties to be
configured on supported property types, the User Option – User Interface - Show Cascade
Properties in View Pane for Object Propertiesmust be enabled.

For properties in the view pane that have content that is longer than two rows, there is now the ability
to expand and collapse the property row to allow improved access to the content in the property row.
Where appropriate, a scroll bar will also be added to the property row in the view pane.

Automatic Container Creation

The automatic creation of records to be used as a container for new records can be configured for
Classifications that are available to the auto-classification process and Check In Styles. This
automated container creation process was previously available for Origins, but its use has been
extended and enhanced in 10.1. Using the Create Container Settings on the supported object types,
Organizations can configure the record type to be used for the automatically created containers,
when containers should be created, as well as defining the metadata to be added as the container’s
title.
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When new records are created using Origins, Classifications, or Check In Styles that have the Create
Container settings configured, whenever records that require a container to be created, based on the
settings defined, a new container will be automatically created, and the record contained within in.

Event Monitor in client

The Event Monitor option in the Content Manager client gives users with the required permissions to
Content Manager, but who do not have access to Content Manager Enterprise Studio, the ability to
monitor the Event Processing status for the available Workgroup Servers.

To access the Event Monitor in the Content Manager client, from the Administration ribbon, in the
Other group, click Event Monitor.

The Event Monitor window will open displaying all active events with their processing data.

Export Metadata

The Export Metadata Tool is a new utility available in the Content Manager Client, or it can be
invoked using the Content Manager command line interface. As the name implies, it may be used to
export the metadata associated with existing records. The interface and functionality are closely
modeled on the existing Print Merge tool, but with one major improvement, namely optimized fields.
These are fields that can be efficiently retrieved from the database, so exporting ‘only’ these fields
can greatly improve export operations. Currently it only supports the exporting of Records.
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Record Store Transfer

Accessed via the Administration ribbon, in theOther group, the new Record Store Transfer
feature provides support for the migration of electronic records from normal document stores to SEC-
compliant stores. Using this feature organizations can define what components of records, that is, the
main document, renditions and revisions, are to be included in the transfer. As this new transfer
option is not an ‘all documents to a new store’ transfer option, it may also be useful for organizations
who have a requirement for geographically localized stores to their users as it allows for the transfer
of specific documents to different stores.

This Record Store Transfer feature can also be run via the Content Manager Administration
Command Line Tool. The required settings file is generated via the Content Manager client Record
Store Transfer dialog, and then can be executed using the Command tool.
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Theme: Total Cost of Ownership

XDMS (External Document Management System) Integration

Some new API methods have been added to allow records to be linked by an External Identifier to an
external document management system. The primary purpose of implementing this linkage is to
allow the advanced retention system to incorporate a confirmation loop to ensure the external
document system doesn’t get left with pointers to orphaned records.

As part of the advanced disposition feature, Content Manager automatically detects consignments
that contain externally managed records and then requires an acknowledgment from the external
system before disposal can proceed. This applies only to “Destroy” consignments, the
acknowledgment can be done either manually using the user interface or automatically by having the
external system poll the SDK for records pending destruction.

The following Content Manager objects constitutes the XDMS system:

l New Record types (External DMS Folder/Document)

l New state with consignment approval process to confirm from the external system to proceed with
disposal process.
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Theme: Lifecycle Management

Advanced Disposal Processing

As a part of the Advanced Disposal Processing feature, a new component has been introduced,
Consignment Templates. Multiple Consignment Templates can be created for each Consignment
type and they allow Organizations to create generic templates that can be used as a starting point for
the creation of Consignments. These templates can also be used for automating the process of
creating Consignments using the Content Manager Administration Command Tool, or via the
Windows Task Scheduler.

There is now also the option to create a default Consignment Log Layout for each Consignment
type via the System Options – Disposal page. A default log format can be created for each type of
Consignment to contain specific record metadata relevant to the Consignment type, and can be
selected to use on Consignment Templates, or Consignments as they are created. Organizations
can also modify this layout ‘on the fly’ on individual Consignment Templates or Consignments, if
required.
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Microsoft Office Integration

Theme: User Experience

Email notifications - support secure SMTP servers with STARTTLS

Content Manager 10.1 supports the STARTTLS security option for connecting to SMTP servers,
when sending email alerts and notifications. This option is necessary when using an Office 365 mail
server. This new option is accessed and configured in the Content Manager Enterprise Studio, from
the Home ribbon, in theGeneral group, clickOptions - Email Notifications tab.
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Content Manager SharePoint Governance and Compliance

Theme: User Experience

Folder mapping for Owners

When folders are created in Content Manager from a SharePoint library, the Owner of the folders is
assigned to the System Administrator account. This automatic assignment of Owner can become an
issue when creating Consignments that require Owner approval, as the Owner is a System
Administrator account, rather than a business Owner. As a result, a manual review of each
SharePoint folder to determine the appropriate Owner before the Consignment is created is required.

This new feature allows the mapping of the Owner column in SharePoint to the Content Manager
Owner field for folders.

Content Manager Infrastructure

Theme: Azure performance

Global Temporary Table

The feature of Global Temporary Table for Azure SQL database is supported in Content Manager.

Theme: Cloud Optimization for MSP vendors

Single Sign On with OpenID Connect

OpenID Connect authentication in Content Manager has been enhanced so that Content Manager
and all Content Manager integrated applications share the same logon credentials, in the same user
session. Consequently, users with multiple Content Manager applications only need to log on once,
and when they sign out, they are automatically signed out of all Content Manager applications.

Theme: Total Cost of Ownership

SQL Text Indexing

IMPORTANT: Please see Upgrade Considerations for information on upgrading to 10.1 and
SQL Text Indexing.

A pre-requisite for using SQL Text Indexing on MS SQL Server and Oracle, is that you must
have their associated 'full text' features installed and configured before upgrading or enabling
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SQL Text Indexing. PostgreSQL has built in support for text searching, so no additional
components are required.

In 10.1, the Content Manager text indexing engine that has been in place for many years has been
fully replaced with the Structured Query Language (SQL) text indexing capabilities built in to modern
relational databases. This capability was first introduced in Content Manager 10.0 as an alternative.
From 10.1 onwards SQL text indexing is the only way to index metadata such as titles, notes, text
type Additional Fields, Classifications, Location Addresses and Names and so on.

The introduction of SQL Text Indexing now indexes the Notes fields of other Content Manager
objects, such as Locations, that were not indexed in earlier releases of Content Manager. Indexing
these Notes fields allows users to now be able to search on the Notes fields for supported objects.

AWS Storage - new authentication options

Content Manager 10.1 supports two new authentication options for AWS S3 document stores -
Amazon Security Token Service (STS), and EC2 Instance Metadata Service (IMDS). The STS option
is necessary for accessing storage in the AWS C2S offering, while the IMDS option allows a
Workgroup Server running on an EC2 instance to use local EC2 metadata to connect to S3.

Post-install client configuration

The Content Manager client installer contains a file CMClientConfig.xml, which allows the
specification of datasets and HKCU registry values. This file can be customized with site-specific
settings and then replaced in the Content Manager client installer. The settings in
CMClientConfig.xml are applied the first time Content Manager runs after installation.
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Enhanced Features

Content Manager Client

Theme: User Experience

Alerts

When creating or modifying Alerts, users now have the option to associate a specific Email Template
to be used when sending the Alert email notification. These Email Templates are only available for
use on Alerts, and are Alert object type specific, they cannot be accessed via the Administration –
Email Templates dialog.

For Alerts created for records, there is a new option for the Alert Subscribers which allows the ability
to select a meta subscriber, rather than individual locations. Each location that is associated to the
selected metadata type(s) that have a valid email address will receive the alert. For example, All
Addressees of the record will be subscribed to the Alert.
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Revisions

The limit on the number of Revisions has been updated and there is now no practical to the number
of Revisions that can be added to records. As a result of this increase, Revisions are now a main
record object. Due to this change, records no longer have a Revisions page as a part of the
Properties form. The Revisions window is accessed via the record’s right-click Electronic – Revisions
menu option, all menu options that were previously available on the Revisions page, and the
Revisions dialog, are available in the Revisions window. Whilst there is an SDK change, see SDK
Breaking Changes, the end user processes for creating Revisions has not changed.
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Working with Thesaurus Terms and Relationships

The process to add and remove Thesaurus Terms and Relationships on multiple records has been
enhanced. For Thesaurus Terms and Relationships new menu options have been added to the
record right-click Detailsmenu.

The dialog used to add and remove Thesaurus Terms is familiar to users as it is the same dialog
used in earlier releases of Content Manager, but we have now separated the add and remove
options to make it a clearer process for users updating Thesaurus Terms for a tagged set of records.

A similar process has been included for record Relationships. Using the Related Records dialog, a
user can create new relationships that can be added to multiple records or identify the record
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relationships that should be removed from multiple records. Again, this dialog is familiar to users as it
is the same used in earlier versions of Content Manager when adding record Relationships, but we
have now extended its use to allow users to also be able to remove record Relationships from a
tagged set of records.

TheMaintain dialog, which is opened using the right-click Details - Browsemenu option, allows
users to add, remove, or work with either the Thesaurus Terms or record Relationships for a single
record, it cannot be used to update a set of tagged records.
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View Rights - Ribbon tab

To enable easier access to determine why certain ribbon options are not available to a user in the
Content Manager client, a new tab called Ribbon has been added to the View Rights dialog.
Displayed in this tab are all the standard Content Manager ribbons (tabs), which can be expanded for
each sub-group within the ribbon, displaying all Content Manager menu options with a Reason for
Denial, if the button is not active.

Edit Caption improvements

The Edit Caption dialog has been redesigned in 10.1. The dialog now allows Administrators to filter
the displayed list of captions to show either Objects, Generic Items or User Option Sets, then to
further filter the list to a specific object type, e.g., Actions other relevant filters, depending on the
selected category. Administrators can also further refine the displayed list of captions to include
captions that only match a particular search term. Captions that have the search term in the Internal
Name or Description will be returned in the search list. Administrators will also notice that the
displayed list of captions is no longer a hierarchical list, but rather an alphabetical list. The structure of
the caption, that is, which object and type it is, is now included in the Description field.

For organizations who have customized captions, these can now be easily found using theOnly
show captions that have been changed option, and by using this in conjunction with the Reset
List option, Administrators can quickly revert all modified caption names back to their default.
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Print Merge improvements

The ability to create Print Merge Configuration files has been introduced. These Print Merge
configuration files allow users to create template Print Merge files which can be saved for easier
creation of Print Merge documents, shared with other users via an Export and Import function, and
easily loaded via the Print Merge dialog, saving time and effort in having to rebuild a Print Merge each
time they need to generate a Print Merge for the different tasks they complete. Using the Print Merge
Configuration option, users can create a ‘default’ template, which will be applied each time they
create a Print Merge document.
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The Print Merge dialog has also been enhanced to include Add, Remove, and Remove All options, to
also help easier building of a Print Merge. Users can now also rearrange the position of the items in
the Print Merge document using the new Up and Down options.
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Option to use a Check In Style for record creation

From the Content Manager User Options – Documents page, users can set a default Check in Style
to be used when dragging and dropping a document on to Content Manager to create a new record.
The Check In Style’s Record Type will be selected by default on the Check In document dialog, and
any default settings associated with the Check In Style will be applied to the new record. This default
Check In Style will also be used when processing a dropped folder, or multiple documents.

Ability to set the format of the URL Link

When creating an URL Link from Content Manager, users now have the option to select a display
format for the link, either Windows Client format, e.g.,
contentmanager://record?DB=45&Type=97&Items=1&[Item1]&URI=1 or the format defined by the
Content Manager Web Server URL in the System Options – Web Services page; Administrators
can also set this option as a Global Setting, if required. The selected format will be used when a link is
added to a document/email by dragging and dropping a record from Content Manager, or by using
the right-click Copy Link option, which also allows users to create a single link for multiple
records/objects.

Theme: Lifecycle Management

Transfer Consignment acknowledgment

As a part of a Transfer consignment, there is an option to flag a Consignment, or Consignment
Template that the Consignment cannot be completed until acknowledgment that the transfer has
been received by the Organization. In earlier versions of Content Manager, this flag was set on the
Consignment as a part of the Disposal process, rather than during creation, which meant that it
possible the disposal process could proceed without acknowledgment being received. To improve
this behavior, for Transfer Consignments and Templates, the optionWait for a transfer
acknowledgment before disposal is now available on the Properties - General tab.
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Theme: Total Cost of Ownership

Document Store Pools

In previous releases of Content Manager, when creating Document Stores, organizations had the
option to associate the store to the general document storage pool. In this release, the Document
Pool option has been extended to allow for multiple Document Store Pools to be created and
assigned to Document Stores, or to Record Types, to allow Content Manager to save new electronic
objects to the best available store within the selected pool.

Easier access to Log files (Setup Info)

To allow for easier access to the Log files generated by Content Manager processes, the Content
Manager Setup Information window, accessed via the File ribbon, now contains a group called Log
Files. Within this group, there are sub-groups for Client Logs and Server Logs, with a list of the latest
log files that have been created available. The log files can now be opened directly from the Content
Manager Setup Information window by double clicking the Edit option. TheWindows directory where
all the generated Content Manager log files can be opened directly from this window.
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Microsoft Office Integration

Theme: User Experience

Improved support for remote workers in Office Integration

The Content Manager Microsoft Office integration (Word, Excel, and PowerPoint only) no longer
attempts to connect to Content Manager as the Office Application opens. Instead, the connection is
completed when the user chooses an action from the Content Manager ribbon, or from the Content
Manager options in the File menu. This improves the experience of remote workers who may not
always have a connection to Content Manager.
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Obsoleted Platforms

No platforms have been dropped from the Support Matrix in Content Manager 10.1.

Please refer to CM10.1_Spec.pdf for details on the Support Matrix.

Obsoleted Features
l Support for EMC Centera Document Stores

l Record Annotation feature

NOTE: The record Redaction feature is still available.
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